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Required materials not provided

lon520" & lon 530" Kit - Chef

Kit summary

Kit contents and
storage

IMPORTANT! Do not substitute components from any other Ion sequencing kits. We
have verified this protocol using these specific materials. Substitution may adversely
affect system performance.

IMPORTANT! Store all consumables and cartridges under the recommended
conditions and in an upright position. Do NOT store the Ion S5 Sequencing Reagents
(Cat. No. A27768) on dry ice or in a closed environment where dry ice is present.

Each Ion 520" & Ion 530”4 Kit — Chef contains all materials that are required to prepare
and sequence 8 Ton 530 Chips.

* Catalog No. A27757 supports 8 initializations
* Catalog No. A30010 supports 4 initializations (2 x 200 base-read sequencing runs
per initialization)

On arrival, inspect all consumables and contact Technical Support if any of the
products have been damaged during shipping.

Component Part No. Quantity per kit
A30010 A27757
lon S5™ Chef Supplies A27755 4 boxes 4 boxes
lon S5 Chef Solutions A27754 1 box 1 box
lon 520™ & lon 530" Chef Reagents A27756 1 box 1 box
lon S5™ Sequencing Solutions A27767 1 box 2 boxes
lon S5™ Sequencing Reagents A27768 1 box 2 boxes
Contents Amount / box Storage
lon S5 Chef Supplies (Part No. A27755)
Chip Adapter 2 15°C to 30°C
Enrichment Cartridge v2 1
Tip Cartridge v2 1
PCR Plate and Frame Seal v2 1 each
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Contents Amount / box Storage
Recovery Station Disposable Lid v2 2 15°C to 30°C
Recovery Tube v2 12

lon S5™ Chef Solutions (Part No. A27754)

lon S5™ Chef Solutions 4 cartridges 15°C to 30°C

lon 520™ & lon 530" Chef Reagents (Part No. A27756)

lon 520™ & lon 530™ Chef Reagents 4 cartridges -30°C to -10°C

lon S5" Sequencing Solutions (Part No. A27767)

lon S5™ Wash Solution 4x15L 15°C to 30°C

lon S5 Cleaning Solution 250 mL

lon S5" Sequencing Reagents (Part No. A27768)

lon S5™ Sequencing Reagents 4 cartridges -30°C to -10°C

(Cartridges ship at 2°C to 8°C. Store as
indicated, do not store on dry ice.)

IMPORTANT! Do not store the Ion S5 Sequencing Reagents (Part No. A27768) on
dry ice or in a closed environment containing dry ice.

lon 530" Chip Kit

Description Catalog No. Quantity Storage

lon 530™ Chip Kit (2 x 4-pack) A27764 8 chips 15°C to 30°C

Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide 7
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| Required laboratory supplies

Required laboratory supplies

Unless otherwise indicated, all materials are available through thermofisher.com.
MLS: Fisher Scientific (fisherscientific.com) or other major laboratory supplier.

ltem Source
Non-interruptible Power Supply (UPS) (1] MLS
Thermal cycler with a heated lid MLS
Microcentrifuge!? MLS
P2, P10, P20, P200, P1000 pL pipettor set and filtered tips MLS
0.2-mL Thin wall PCR tubes, flat cap (do not use polystyrene tubes) Axygen
PCR-02-L-C
BioExpress
T-3035-1
1.5-mL or 1.7-mL Microcentrifuge tubes MLS
Vortex mixer with a rubber platform MLS
Gloves, powder-free nitrile MLS
Ice buckets and ice —
Nuclease-free water molecular biology grade MLS
Isopropanol, 70% solution MLS
Wipes, disposable lint-free MLS

1 For laboratories that experience frequent power outages or line voltage fluctuations, we recommend that you
use a non-interruptible power supply that is compatible with 2500 W output or higher.

(21 Must fit standard 0.2- and 1.5-mL microcentrifuge tubes and generate 21,000 x g.

8 Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide
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About the lon Chef  System

lon Chef™
Instrument
components

About the lon Chef" System [\

The Ion Chef™ System provides automated, high-throughput template preparation
and chip loading for use with the Ion S5™ or Ion S5™ XL Sequencer. The system
includes a complete set of cartridge-based consumables and reagents that enable a
user to load two Ion 530™ Chips in approximately 13 hours with less than 15 minutes
of hands-on time. The Ion Chef™ System features network integration with the Torrent

™

Suite™ Software to enable sample and reagent traceability throughout the chip

preparation workflow.

The following figure illustrates the major external and internal features of the

Ion Chef" Instrument.

@ Door - Provides access to the interior of
the instrument. The door is locked in the
closed position during operation.

©) Micropipettor - A mechanical positive-
displacement pipettor that performs all
fluid transfers during sample and chip
preparation.

@ Robotic arm - Performs fluid transfer
during chip loading. The arm also
contains an optical sensor that reads the
barcodes of instrument reagents and
consumables.

@ Touchscreen - Provides access to all
instrument functions for operation,
maintenance, and troubleshooting.

k.

®

@ Power button - Power switch for the
lon Chef" Instrument, where the states
are on (illuminated) and off.

(® Power port - A 100-240 VAC port that
provides power to the lon Chef"
Instrument.

(D Ethernet port - An RJ45 port that provides
Ethernet (100 Mbit) communication with
the lon Chef" Instrument.

USB port - Provides USB communication
with the lon Chef" Instrument. Used to
update the instrument firmware and to
transfer data during service or
maintenance.

Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide 9
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bout the lon Chef" System

The following figure illustrates the interior of the Ion Chef ' Instrument and describes

nd consumables the stations involved in the preparation of chips for sequencing on the Ion S5 or Ion
S5 XL System.

@)

O )

[eevessse

06000000

®

(D Waste pipette tip rack - The position of
the rack containing waste (used) pipette
tips.

@ Automated heated cover - Transfers the
plate cover to the PCR reaction plate
within the sample block. During thermal
cycling, the heated cover applies
compression to seal the reaction plate
and heats the cover to prevent
condensation.

® New pipette tips - The position of the rack
containing unused pipette tips.

(® Thermal cycler sample block - Performs
thermal cycling of the sequencing
reactions on a 96-well PCR reaction plate.

@ Reagents station - The position on the
instrument deck of the diluted libraries,
NaOH, and the lon 520" & lon 530" Chef
Reagents cartridge.

(® Solutions station - The position on the
instrument deck of the lon S5 Chef
Solutions cartridge, which is maintained
at room temperature.

(D Recovery centrifuges - Twin stations that
perform centrifugation of the ISPs during
the recovery phase of template
preparation.

Enrichment station - The position of the
rack containing consumables for the
enrichment of the template-positive ISPs.

(® Chip-loading centrifuge - Performs
centrifugation of sequencing chips that
have been mounted to chip-loading
adapters and loaded with template-
positive ISPs.

Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide
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About the lon The Ion Chef System features a simple interface for loading chips, cleaning the
Chef™ System instrument, and performing system maintenance and configuration tasks.
touchscreen

interface lon Chef

M set up Run button - Set up the lon Chef”
template preparation and chip-loading
routine. Choose Step by Step to have the
instrument lead you stepwise through
installation of reagents and consumables,
or choose Quick Start to proceed if you
have already installed the consumables.

® Open Door button.

@ Notifications button - View notifications
about instrument status during and
between runs.

(® Quick Start button - Proceed directly to
the Quick Start instrument setup mode.
User verifies the loading of a new pipette
tip cartridge and an empty pipette tip rack
to hold waste tips generated during the
run, before proceeding to Deck Scan.

® Settings button - Advance to a screen

providing the following options:

* Notifications: view notifications about
instrument status during and between
runs

e Instrument Settings: view current
settings and network configuration,
set instrument name, adjust time zone

e Service tools: access screens for
service-related maintenance and
instrument diagnostics

¢ Torrent Server: add and manage
Torrent Server connections

e Clean lon Chef: proceed directly to the
instrument cleaning routine

e Check for updates: check availability
of system software updates

Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide 11
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Guidelines for using lon Chef" reagents and consumables

Guidelines for using lon Chef reagents and consumables

To ensure the proper function of the Ton Chef System, handle the associated
consumables and reagents according to the following guidelines:

Precautions

Store all Ion Chef ' System consumables and cartridges under the recommended
conditions and in an upright position.

Inspect all Ton Chef " System consumables and cartridges for damage on arrival
and again before use.

Hold sequencing chips by gently gripping them by their edges.

When the Ton Chef' System is not in use, remove all consumables and reagents
from the deck and close the instrument door.

Except for the New Pipette Tip Cartridge v2, do not reuse any of the Ton Chef -
System consumables or reagents. After each run, the empty Pipette Tip Cartridge
v2 is transferred to the waste tip station.

IMPORTANT! AllTon Chef ' Instrument components are single-use only.

Use only Ion Torrent " kits and supplies with the Ion Chef ' Instrument. The use
of third-party reagents and supplies can adversely affect the performance of the
Ton Chef ' Instrument and chips prepared.

Always load two of the same model of sequencing chips into the Ion Chef
System. The instrument cannot load different models of sequencing chips during
the same run.

Remove and sequence chips within 1 hour after the Ton Chef ' System finishes
loading them. If you cannot sequence a loaded chip immediately, store it in a chip
storage container at 4°C until you are ready to run it (up to 6-8 hours maximum).

Note: If you choose to store a loaded chip, remove the chip from 4°C storage (but
keep it in the chip storage container) at least 20 minutes before running it,
allowing the chip to warm to room temperature.

Avoid nucleic acid

IMPORTANT! A primary source of contamination is spurious DNA fragments from

contamination previous sample processing steps. Do not introduce amplified DNA into the library
preparation laboratory or work area.

Avoid chip damage

IMPORTANT! To avoid possible damage to the chip due to electrostatic discharge,

ground yourself before picking up a chip or placing a chip on a surface such as a lab
bench. For example, touch the metal trim on the chip compartment before inserting or
removing a chip from the chip clamp.

12 Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide
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Before you begin

)

Workflow

The following workflow illustrates how to prepare and load samples using the
Ton 520™ & Ion 530™ Kit — Chef, and Ion Chef™ System for sequencing on the Ion S5™
or Ion S5™ XL Sequencer. For robust detection of low frequency somatic variants from
liquid biopsy samples we recommend to multiplex up to:

* 8 Oncomine™ Lung cfDNA Assay libraries on a single Ion 530™ chip.

* 6 Oncomine™ Colon cfDNA Assay libraries on a single Ion 530™ chip.

* 12 Oncomine™ Breast cfDNA Assay libraries on a single Ion 530™ chip.

Create a Planned Run within the Torrent Suite™ Software
and set the run parameters.

v

Dilute the library samples, and thaw the reagents.

v

Load the lon Chef™ Instrument with sequencing chips,
consumables, reagents, and libraries.

v
Start the lon Chef" Instrument
v

Unload the lon Chef™ Instrument.

v

Load the prepared chip into the lon S5" or lon S5™ XL Sequencer and
begin the sequencing run.

Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide 13
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Create a Planned Run
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Create a Planned Run

Planned Runs contain all the settings used in a sequencing run, including number of

About planned

runs Runs are used to track samples, chips, and reagents throughout the sequencing
workflow, from template preparation on the Ion Chef™ Instrument through
sequencing on the Ion S5™ or Ion S5™ XL Sequencer and subsequent data analysis.
Each chip prepared in an Ion Chef™ run requires its own Planned Run.
In Torrent Suite™ Software, the Planned Run templates to be used with the
Oncomine™ cfDNA Assays are listed in the following table:

Application TorrenttSet:TlitpelatSeoftware Description
Oncology - Liquid Oncomine”™ Lung Liquid Planned run template for use
Biopsy Biopsy DNA with cell-free DNA (cfDNA)

Oncomine™ Colon Liquid research samples. Analysis
Biopsy DNA parameters are optimized for
Oncomine™ Breast Liquid the sepsitive and Spec”fc
Biopsy DNA det_ectlon of rare somatic
variants (SNPs, InDels) present
at 0.1% frequency in cfDNA.
Oncomine™ Lung Tumor Planned run template for use
DNA with solid tumor research
Oncomine" Colon Tumor samples from FFPE as well as
DNA fresh frozen tumor tissue.
Oncomine™ Breast Tumor Anqu§is parameters are
DNA optlml.zed for the sensitive and
specific detection of rare
somatic variants (SNPs, InDels)
present at 0.5% frequency.
Analysis parameters are
optimized to eliminate false
positives due to DNA damage
resulting from formalin fixation.
14 Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide
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Create a Planned Run '

Create a custom

IMPORTANT! Before creating a template file the target region and hotspot BED files

Planned Run must be uploaded to the Torrent Server. Required files can be found on the Ion

template Community Oncology — Liquid Biopsy page. If using TS v5.0, additional instructions
to create a planned run are also available. See Appendix B, “Supplemental
procedures” for more information.

We recommend setting up a customized Planned Run template for reuse when the
same conditions will be used for multiple runs. For more information about creating
Planned Runs manually or from the generic application template, see the Torrent Suite
User Documentation available through the Help » Software Help menu in the Torrent
Browser software.

1.

5.

T™

Log in to the Torrent Browser for the Torrent Server connected to your Ion Chef
System.

Click the Plan tab » Templates, then click Oncology - Liquid Biopsy in the left
navigation menu.

Find the appropriate Oncomine™ Liquid Biopsy DNA (Lung, Breast, or Colon)
template in the Oncology - Liquid Biopsy list, click & then select Copy.

™

Note: Select the appropriate Oncomine™ Tumor DNA (Lung, Breast, or Colon)
template from the list if creating a solid tumor run template.

The copy template wizard will open to the Save tab.

Enter or select the required information in each field:

Field Action...
Template Name Enter a name for the Planned Run template.
Reference Library Select hg19(Human (hg19)).
Target Regions Select the appropriate Target Region file:

e Oncomine_Lung_cfDNA.06012016.Designed.bed
e Oncomine_Colon_cfDNA.10242016.Designed.bed
e Oncomine_Breast_cfDNA.08032016.Designed.bed

Hotspot Regions Select the appropriate Hotspot Region file:

e Oncomine_Lung_cfDNA.06012016.Hotspots.bed
e Oncomine_Colon_cfDNA.10242016.Hotspots.bed
e Oncomine_Breast_cfDNA.08032016.Hotspots.bed

Click the Ion Reporter tab:

¢ To export files for analysis using Ion Reporter, select your Ion Reporter
Account, select Automatically upload to Ion Reporter after run completion
as Sample Grouping, then click Next.

* If performing analysis using only the variantCaller plugin of the Torrent
Suite™ Software, ensure None and Self are selected for the Ion Reporter
Account and Sample Grouping respectively, then click Next.

Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide 15
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6. In the Application tab, verify that Oncology-Liquid Biopsy and Tag Sequencing
are selected for Application and Target Technique respectively, then click Next.

7. In the Kits page, verify the Ion Chef Template Kit radio button is selected, and
the following fields are completed:

Field Selection
Instrument lon S5 System
Library Kit Type Oncomine cfDNA Assay
Read Length 200
Template Kit lon 520™ & lon 530™ Kit - Chef
Sequencing Kit lon S5™ Sequencing Kit
Base Calibration Mode Default Calibration
Chip Type lon 530™ Chip
Barcode Set lonCode™ - TagSequencing
Flows 500

8. Select or edit the optional information fields appropriately for your run, then
click Next.

9. In the Plugins tab, ensure variantCaller is selected, then click Configure.

10. In the Plugin Configuration dialog choose the following Parameter Settings:

If setting up an ... Select the Parameter Setting
Oncomine” Liquid Biopsy DNA Oncomine” Liquid Biopsy DNA - PGM (318) or
template S5/S5XL (5xx)

Oncomine” Tumor DNA template Oncomine” Tumor DNA - PGM (318) or
S5/S5XL (5xx)

11. Review the Projects tab and make selections appropriate to your run, then click
Next.

12. In the Save tab, click Copy Template to save the new run template.

The customized template is now available in the Oncology - Liquid Biopsy page.

TM

Create a Planned 1. Login to the Torrent Browser for the Torrent Server connected to your Ion Chef
Run System.

2. Click the Plan tab » Templates, then click Oncology - Liquid Biopsy in the left
navigation menu.

3. In the Oncology - Liquid Biopsy list, click on your customized Planned Run

template name or the provided Oncomine™ Liquid Biopsy DNA template,
alternatively click §# then select Plan Run.

The create plan wizard will open to the Plan tab.

4. Enter a Run Plan Name.

16 Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide
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Create a Planned Run 55"

5. Verify the Use same reference & BED files for all barcodes radio button is
selected.

6. In the Number of barcodes field, enter the number of barcodes that will be used
in this run, then click the check mark @ button to the right of this field.

7. In the Sample Tube Label field(s), enter or scan the barcode of the Ion Chef™
Library Sample Tube that will be used in the run.

8. For each sample select the Barcode that will identify it, then enter or select from
the available dropdown list the appropriate information for each field (all fields
are required except Sample Description and Sample ID).

IMPORTANT!

- Sample Names must be unique to each sample. Do not duplicate sample
names.

- Set the IR Set ID to the same value for related samples. In Ion Reporter™
Software, samples with the same Set ID are launched in the same analysis.

@ R set

4

# Barcode Sample (required) Sample Description Sample ID fon Reporter Workflow Relation Gender

lonCodeTag_0101 (CTAAGGTAAG) ¥  Sample 1 Upload Only v el v [0 [§
lonCodeTag_0102 (TAAGGAGAAC) ¥  Sample 2 Upload Only v sl v
lonCodeTag_0103 (AAGAGGATTC) ¥  Sample3 Upload Only v sl A

lonCodeTag_0104 (TACCAAGATE) ¥ Sampled Upload Only v el v

lonCodeTag_0106 (CTGCAAGTTC) ¥  Sample 6 Upload Only v Self v

lonCodeTag_0107 (TTCGTGATTC) +  Sample? Upload Only v Self -

@ 4 @ o e oW N -

1

1

1

lonCodeTag_0105 (CAGAAGGAAC) ¥  Sample 5 Upload Only v Self v v
1

1

1

lonCodeTag_0108 (TTCCGATAAG) ¥  Sample 8 Upload Only v sl v

9. For each sample select the Barcode that will identify it, then enter or select from
the available dropdown list the appropriate information for each field (all fields
are required except Sample Description and Sample ID).

IMPORTANT! Sample Names must be unique to each sample. Do not duplicate
sample names.

10. Click Plan Run.

The run is listed in the Planned Run List page under the name that you specified and
is automatically used by the Ton Chef ' System when the associated Ion Chef "~ Library
Sample Tube is loaded.

Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide 17
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Dilute the library

Dilute libraries according to the following table. Then use polyclonality and low
quality filter results from a sequencing run performed with ISPs templated at the
starting concentration and titrate up or down to achieve optimal concentrations, if
necessary. The quality of your sequencing data relies greatly upon achieving the
correct concentration of starting library.

IMPORTANT! The recommendations in parentheses represent optimal input
concentrations for control libraries.

Library read length Recommepdeg] Molecules per 25-pL input
concentration volume
200 bp 50 pM (40-60 pM) 600-900 x 106

[ Recommendations are based on gPCR quantification. If libraries are quantified with a 2100 Bioanalyzer™
instrument, a higher calculated concentration may need to be used for equivalent input.

T™M

Note: Prepare a fresh dilution of each library before use with the Ion Chef™ System,
and use the library dilutions within 48 hours.

Prepare the lon Chef  System for use

Before you use the Ton Chef ' Instrument:

e Ensure that the Ion Chef™ Instrument has been cleaned following the previous
run. If not, clean the instrument before loading it with consumables.

Note: For more information on the cleaning procedure, see Chapter 6, “Clean the
Ion Chef™ System”.

¢ Inspect the empty compartments of the Reagents and Solutions stations for
condensation. Condensate can collect in these compartments, depending on
temperature and humidity conditions. Before loading consumables into the
instrument, wipe the compartments dry with a laboratory wipe or absorbent
cloth, if needed.

e Thaw the Ion 520™ & Ion 530™ Chef Reagents cartridge at room temperature for
45 minutes before use.

e Ensure that the Ion Chef™ Instrument has a connection to your Torrent Server. On
the Ion Chef™ home touchscreen, touch Settings, then Torrent Server to view the
connection status of your instrument.

™

Note: If the instrument is not connected, see Appendix C in the lon 520™ & lon
530™ Kit — Chef User Guide (Pub. No. MAN0010846) for instructions on how to
configure a direct or indirect network connection of the Ion Chef™ Instrument to a
Torrent Server.

18 Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide
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This chapter describes:

T™

Run the lon Chef " System

* Setting up the Ion Chef™ Instrument for use by diluting the two Ion libraries, and

loading the instrument with all of the required reagents and consumables
* Starting an Ion Chef™ run

* Unloading the Ion Chef™ Instrument

Materials required

e Ton 520™ & Ion 530™ Kit — Chef (Cat. Nos. A27757, A30010)
e Jon 530™ Chip (2)

* Molecular-biology grade nuclease-free water

* P200 pipettor and filtered tips

Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide
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Prepare the libraries and consumables

Prepare the libraries and consumables

20

1.

Unbox the Ion 520™ & Ion 530™ Chef Reagents Cartridge at least 45 minutes
before use and allow it equilibrate to room temperature.

Pipet 25 pL of each 50-pM library (see “Dilute the library” on page 18) to the
bottom of the appropriate Ion Chef™ Library Sample Tube (flagged tubes).

Cap, then store the two diluted libraries on ice until you are ready to load them
onto the Ion Chef™ Instrument.

Remove all cartridges and consumables from their wrappings and boxes, then
place them on the bench next to the Ion Chef™ Instrument.

Prepare the following;:
e Chip Adapter (2)
¢ Enrichment Cartridge v2
¢ Tip Cartridge v2
* PCR Plate and Frame Seal v2
* Recovery Station Disposable Lid v2 (2)
* Recovery Tube v2 (12)
e Jon S5"™ Chef Solutions Cartridge
e Jon 520™ & Ion 530™ Chef Reagents Cartridge (from Step 1)

IMPORTANT! Before use, gently tap the solutions and reagents cartridges on the
bench to force the reagents to the bottoms of the tubes.

Note: When stored under normal conditions, a precipitate can form in some
tubes of the Ion 520™ & Ion 530™ Chef Reagents Cartridge. If present, load the
cartridge as directed — the precipitate will dissolve when the reagents are mixed
during instrument operation.
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Load the lon Chef  System

IMPORTANT!

. Rated centrifuge speeds are only intended for operation with the provided buckets
and approved consumable chips, tubes, and sample preparation reagents.

- The Chip-loading centrifuge is rated to operate at the listed rotational frequencies
with the chip buckets, chips, and adapters. The centrifuge must be load-balanced.
Proper care must be taken to load the buckets properly. If excessive vibrations arise,
check that items are installed properly and rotors are load-balanced.

- Use only the materials supplied in the Ion 520™ & Ion 530™ Kit — Chef to run the
centrifuges at the rated speeds. Do not remove or change the rotors. Inspect the
buckets before each use to assure normal operation.

- Confirm that the instrument is powered ON and has been cleaned following the
last use.

- Ensure all components are clean and dry before loading them onto the Ion Chef™
Instrument.

- Ensure the Reagents and Solutions station compartments are free of condensate
before loading components.

T™

Follow the procedure below to load the Ion Chef™ Instrument. A completely loaded
instrument is shown in the following figure:

4

1000000000000

J

(eeseensne
Q

00006000)

= G
’}‘ P L
@L ®

(D Empty tip rack (move from new Tip (® lon S5™ Chef Solutions Cartridge

Cartridge position) (7) Recovery Tubes and Recovery Station
(2 Frame Seal v2 Disposable Lid v2

New Tip Cartridge v2 (8) Enrichment Cartridge v2

p g g

PCR plate Chip Adapter/Chip assemblies
® PCRp p Adap p
(® lon 520™ & lon 530™ Chef Reagents

Cartridge
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Load the pipette 1. Touch @) (Open Door) in the instrument touchscreen to open the instrument
tip racks and PCR door, then wait for the latch to open.
plate 2. Lift the instrument door to the top of the travel until the latch mechanism

engages.

(D Hold here, then lift

3. Load an empty pipette tip rack to the Used (Waste) Pipette Tip Position, then
change gloves.

@ Used Pipette Tip Position

IMPORTANT!

- Confirm that the pipette tip rack in the Used (Waste) Pipette Tip Position does
not contain any tips. The instrument will abort the run if tips are present in the
used position.

- To prevent contamination, change gloves immediately after moving the empty
pipette tip rack to the Used (Waste) Pipette Tip Position.

Note: A small amount of dried residue may be present in the tub of the empty
pipette tip rack after a run. This will not affect the next run in the Used Pipette
Tip Position.

4. Unwrap a new Tip Cartridge v2 and remove the cover to expose the pipette tips,
then load it in the New Pipette Tip Position.

Note: Two Ion Chef™ Piercing Tips are pre-loaded into tip positions G7 and H7
on the Tip Cartridge v2.
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5. Pull the catch forward, then pivot the locking bracket upwards. Load the
assembled Tip Cartridge v2 into the New Pipette Tip Position, then pull the
bracket downwards, then push the catch backwards to lock the cartridge in place.

@ New Pipette Tip Position
(2 Bracket

(3 Catch

@ New Tip Cartridge

6. Load a new PCR plate into the thermal cycler sample block, then slide a new
Frame Seal v2 underneath the automated heated cover.

IMPORTANT! When the Frame Seal v2 is positioned correctly, its tabs project
upward and contact the heated cover.

(D Thermal cycler sample block
(2 Well AT

(® Cover

(® Keyed corner
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.‘:?:L‘i Load the lon Chef" System
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Load the Reagents IMPORTANT! Thaw the Reagents cartridge at room temperature for 45 minutes
and Solutions before use.

cartridges

1. Gently tap the Ion 520™ & Ion 530™ Chef Reagents Cartridge on the bench to
force the reagents to the bottoms of the tubes.

2. Load the cartridge into the Reagents station so that it snaps into place and is level
on the deck.

IMPORTANT! Do not force the Ion Chef™ cartridges into place. Each cartridge
fits only one location on the deck and in one orientation. If a cartridge does not
fit, confirm that you are loading the correct cartridge in the correct orientation.

(D Reagents station (4°C)
(2 lon 520™ & lon 530™ Chef Reagents Cartridge

3. Uncap, then load the two Library Sample Tubes, each containing 25 L of diluted
library, into Positions A and B on the Reagents cartridge.

e N
— —

gyl

— —
. J

(D) Position A [Library)

(2 Position B (Library)

(3 Position C (NaOH)

(®) Position D ([Empty tube)
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IMPORTANT!

- Make sure to orient the sample tubes so that the barcodes are visible and
oriented to the right.

- Make sure to remove the caps to the Library Sample Tubes before proceeding.

- Because 200- and 400-base-read libraries require different run lengths, do not

load a 200-base-read library and 400-base-read library in a single Ion Chef™
run. Both libraries loaded in a run must have a similar read length.

. Uncap both the tube of NaOH in Position C and the empty tube in Position D on

the Reagents cartridge.
IMPORTANT! When the Reagents cartridge is loaded:

- Press down on the Library Sample Tubes to ensure that they are firmly seated
in the cartridge.
- Confirm that all tubes are uncapped, including the tube at Position D.

™

Gently tap the Ion S5™ Chef Solutions Cartridge on the bench to force the
reagents to the bottoms of the tubes.

. Load the Solutions cartridge into the Solutions station until it snaps into place

and is level on the deck.

(™ Solutions station (room temperature)
(@ lon S5™ Chef Solutions Cartridge

. Load six Recovery Tubes (v2) into each Recovery centrifuge.

NS

iz
g3

S3as
-

(D Recovery centrifuges
(2 Recovery Tube
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Before sealing each centrifuge, confirm that:

¢ The centrifuge is load-balanced with all required consumables.

IMPORTANT! The centrifuge must be load-balanced.

¢ The buckets are securely seated in the centrifuge rotors.

* The buckets are oriented correctly in the centrifuge so that they pivot
outwards.

2. Place a Recovery Station Disposable Lid v2 over each centrifuge with the port
oriented toward the rear as shown in the figure below, then press down. Make
certain the lids snap completely into place by applying firm downward pressure
along the lid perimeter.

3. Close the hinged cover of the Recovery centrifuges. Confirm that the port of each
disposable lid is positioned toward the rear of the instrument.

00000000

00000000 -

00000000
|t = Sttt |

(D Recovery Tubes installed
@ Recovery Station Disposable Lids installed
@ Recovery centrifuge cover closed

® Port

IMPORTANT!
- Do not obstruct or place any object on top of the Recovery centrifuge cover.

- Use only the supplied materials, including buckets and disposables, to run the
centrifuges at the rated speeds. Do not remove or change the rotors. Inspect
the buckets to assure normal operation before each use.

26 Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide



)
Xen

Chapter 3 Run the lon Chef™ System
Load the lon Chef" System

O
X

g

0 )
{
=

4. Load the Enrichment Cartridge v2, then press down on the cartridge to ensure
that it is level with the instrument deck.

IMPORTANT! Confirm that the Enrichment Cartridge v2 is loaded so that the
lettering on the cartridge is right-side-up.

)

I
%E

(D Enrichment station
(@ Enrichment Cartridge v2

@ Lettering
Load the Chip- 1. Load each prepared sequencing chip
loading centrifuge into a centrifuge bucket, then attach

a Chip Adapter to the assembly.

a. Place the chip in the chip-
loading bucket, then align the
wells of the Chip Adapter to the
wells of the chip, orienting the
adapter onto the chip so that the
chip barcode is visible.

. Chip Adapter
b. Place the adapter onto the chip, lon chip
then insert the stationary tabs at Bucket

the reservoir end of the adapter

into the slots of the bucket. Ports [align with chip]

Flexible tabs

c. Gently squeeze the flexible tabs Keyed corner (align with bucket]

at the other end of the adapter Slots
into the bucket slots until the adapter locks into place.

CICICICACRCRC)

d. Confirm that the tabs at all four corners of the adapter are fitted into the
slots in the centrifuge bucket. Loading can fail if the adapter is not attached
securely.

Note: If desired, you can label the tops of chips to distinguish them. Do not
obstruct or overwrite the chip barcode with your label.

Oncomine™ cfDNA Assays, Part Il: Plan a Run, Template Preparation, and Sequencing User Guide 27



3

28

Chapter 3 Run the lon Chef™ System
Load the lon Chef™ System

2. Load the adapter/chip/bucket assemblies into the Chip-loading centrifuge.

(‘D Chip-loading centrifuge
(2) Mounting grooves

IMPORTANT! When the Chip-loading centrifuge is loaded, confirm that each
Chip Adapter is firmly attached to a bucket, and that the buckets are securely
seated in the centrifuge rotors.

(D Chip barcode

(@ Chip position 1

(3 Position 1 marker hole
@ Chip position 2

(® Position 2 marker hole

Note: Position 1 of the Chip-loading centrifuge is the position 90° clockwise
from the single hole in the rotor bucket cover at rest. The chip loaded in

Position 1 will be loaded with ISPs prepared from the DNA library in the Library
Sample Tube loaded in Position A of the Reagents cartridge. The chip loaded in
Position 2 of the centrifuge will be loaded with ISPs prepared from the DNA
library in the Library Sample Tube loaded in Position B of the Reagents cartridge.
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consumables are
correctly installed

Single chip
loading workflow

Chapter 3 Run the lon Chef™ System 5%
Load the lon Chef" System 540

3. Ensure the centrifuge is load-balanced, and the chip buckets are securely seated

and oriented correctly in the centrifuge so that they pivot 90° outwards when
touched. Then close the lid of the Chip-loading centrifuge.

IMPORTANT! Do not obstruct or place any object on top of the lid.

Before continuing;:

Confirm that each cartridge is at the correct location and in the correct
orientation.

Press down on all cartridges to confirm that they are firmly pressed into place.

Confirm that all tubes on the Ion 520™ & Ion 530™ Chef Reagents Cartridge are
uncapped and firmly pressed into place.

Confirm that the centrifuge lids are installed correctly so that the port is oriented
toward the rear of the instrument.

Confirm that the tube and chip buckets are seated securely in the rotor arms of
the Chip-loading and Recovery centrifuges, and that the consumables they
contain are correctly installed.

C CAUTION! To ensure correct and safe instrument operation, you must confirm

that all consumables are installed correctly to the deck before you start a run.
The Ion Chef™ Instrument does not verify all aspects of the consumable setup
prior to beginning each run.

You can set up an Ion Chef run to load a
single chip instead of two, using the

Ton Chef" S5 Series Chip Balance loaded
opposite to the sequencing chip in the |
Chip-loading centrifuge. The Ton Chef | chip Balance
S5 Series Chip Balance is provided in the ‘
Ton S5 Installation Kit.

Load the Ton Chef ' Instrument as you

lon Chef™
S5 Series

e

would normally load the system. For
single chip loading, perform the

following steps:

1.

lon Chef™ S5 Series Chip Balance

Add the single diluted library to an Ion Chef™ Library Sample Tube, then load
the tube into Position A of the Reagents cartridge.

Load an empty Ion Chef™ Library Sample Tube into Position B of the Reagents
cartridge. Uncap both tubes.

T™

Load the chip in Position 1 and the Ion Chef™ S5 Series Chip Balance in Position 2
of the Chip-loading centrifuge.

IMPORTANT! Do not use Ion Chef™ 314, 316/318, or P-Series versions of the chip
balance with the Ion 520™ or Ion 530™ Chip. Each chip balance is weight-matched
to the chip (and corresponding chip adapter) specified on the chip balance label.
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Load the lon Chef" System

4,
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Note: Position 1 of the Chip-loading centrifuge is the position 90° clockwise
from the single hole in the rotor bucket cover at rest.

lon Chef™

S5 Series
‘ = Chip Balance

(™ Position 1 (chip)

(2 Position 2 marker holes
(3 Position 2 (Chip Balance)
(® Position 1 marker holes

Resume the normal workflow in “Load the Chip-loading centrifuge” at step 3.
The Ion Chef™ Instrument detects the presence of the single chip during Deck
Scan before the run starts.
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Chapter 3 Run the lon Chef™ System
Load the lon Chef" System

0
B
=&

O
B

lon Chef" pre-run checklist

[0 1) A new PCR Plate is loaded in the thermal
cycler sample block.
[0 2) A Frame Seal v2 is in place and oriented

under the heated cover. [0 1) The tip rack from previous run is transferred

[ 1) A new lon Chef™ Tip Cartridge v2

is loaded in the New Pipette Tip position. from the New Pipette Tip position to the
[ 2) Bracket is pulled downward to lock the Used Pipette Tip position.

tip cartridge in place.

[ 1) Reagents cartridge contents are
thawed (leave at room temperature
for 45 minutes).

[1 2) Reagents cartridge tubes are
uncapped and pressed into place at the "ggfil
Reagents station so that the tubes are J*% °:
firmly seated and level with the deck. @\gg

[ 1) Recovery Tubes (v2) are securely seated

in the Recovery centrifuge buckets.

[ 2) Recovery centrifuges are load-balanced.

[0 3) Recovery Station Disposable Lids (v2) are
positioned so that the port is correctly

.
L

]

[ 3) Library Sample tubes are firmly seated — \
: ) ) : aa

2nd Indthefco'rreCt’(honggt;tllg’)ln tWIth d 3%00 @ N oriented: port should not be located in the

aps romoved. sean g;go @ position facing the front of the instrument.

caps removed.

t«

[ 1) Solutions cartridge is pressed into
place at the Solutions station so that the O 1) Enrichment Cartridge v2 is pressed into place
cartridge is firmly seated and level with at the Enrichment station so that the cartridge
the deck. is firmly seated and level with the deck.
[ 2) Lettering on the cartridge is right-side up and
O 1) Adapter/chip assembly is correctly positioned to the right of the enrichment tubes.
seated in the Chip-loading centrifuge buckets,
with the adaptor clips inserted into the bucket slots.
[ 2) Centrifuge buckets containing the adapter/chip
assemblies are securely seated in the centrifuge rotor,
and freely pivot 90° outwards.
[ 3) Chip-loading centrifuge is load-balanced.
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Start the lon Chef  run

1. Confirm that you have loaded the instrument with all kits and consumables.

2. On the Ion Chef™ Instrument home touchscreen, touch Set up run.

3. Touch Step by Step to have the instrument lead you through the instrument
setup, or touch Quick Start to skip the instrument setup screens.

Set up Run

C,

| Step by step | Quick start
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=

4. Follow the on-screen instructions. When prompted, close the instrument door by
first lifting it slightly to disengage the locking mechanism, then push down on
the door until the locks engage. After the door closes, the instrument vision
system activates.

IMPORTANT! Do not close the door by pulling it straight down from the open
position. You must lift the door slightly before you can close it. Ensure both sides
of the door are locked after closing it.

() Lift door first

(@) Lower

(3 Press down to lock

5. When prompted, touch Start check to start Deck Scan. Wait while the instrument
scans the barcodes of all consumables and reagents to confirm their presence and
compatibility.

During Deck Scan, the touchscreen displays warnings if the Ion Chef™
Instrument detects missing or incompatible consumables. You must address all
warnings before the run can start. After you address each condition, touch Yes to
continue.

IMPORTANT! The Deck Scan function is not a substitute for manual inspection
of the reagents and consumables on the Ion Chef™ Instrument before starting a
run. To ensure proper and safe instrument operation, confirm that all

consumables are installed correctly before you continue.

6. When Deck Scan is complete, touch Next to display the Data Destination screen.

lon Chef

Deck Scan

Complete
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Start the lon Chef™ run
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7. Confirm that the instrument displays the correct kit type, chip type, chip
barcodes, and Planned Run. If the correct Planned Runs do not display, touch the
dropdown menu [ to select the Planned Run for each chip, then touch Next.

Data Destination

Kit Type lon Chef S$520 V' Chip Type: 520

10.45.19.2:
Chip ID: Chip ID: XX0000191

Sample ID: X0000051 Sample ID: 0000052
ITK4W - TC1_FER-200... ¥ MIYV8 - mt22_fr_prom...

Template size 200 Template size 200

IMPORTANT! If the kit and chip type are not correct, confirm that you are using
the correct kit and chip. If you are using the correct kit and chip, and an incorrect
kit or chip type is displayed on the screen, contact Technical Support.

8. On the Run Options screen, touch the appropriate option to complete the run,
then enter the desired time of run completion, if needed.

Run Options

fins 05:38PM PST

Choose the approximate time
you want your run to end.

Pause

i : 05:38PM PST
Run will pause at the time shown

you to analyze templating efficiency.

Start run

The Ion Chef™ Instrument provides two options for obtaining quality control
(QC) samples that can be used to evaluate templating efficiency. Depending on
your selection, the QC samples are made available either during or after the run.
In either case, you can obtain unenriched samples from the corresponding
Library Sample Tubes at Positions A and B on the Reagents cartridge, or enriched
samples from Positions A and E on the Enrichment Cartridge v2.

By selecting You can obtain the QC samples

Time immediately after the run ends, at the time you specify
(12 hours, 45 minutes after run start).

Pause when the instrument pauses operation before the chip
loading step (about 11 hours into the run).
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Note: The library in the Library Sample Tube loaded in Position A will be
templated onto ISPs that can be sampled in Position E of Enrichment Cartridge
v2 after a run. The library in the Library Sample Tube loaded in Position B is
templated onto ISPs that can be sampled in Position A of Enrichment Cartridge
v2.

9. On the Run Options screen, touch Start run to begin the run.

Note: If you need to stop the run for any reason, touch Cancel, then touch Yes to
confirm the cancellation.

If the Ion Chef™ Instrument encounters a problem during the run, it aborts the
run and displays the error on the instrument touchscreen. If a run fails:

a. Remove the consumables from the deck, then clean the instrument. If
possible, retain the consumables for troubleshooting.

b. Reset, then reattempt the run. If the run fails again, contact Technical
Support to troubleshoot the problem.

10. Initialize the Ion S5™ or Ion S5™ XL Sequencer at least 40 minutes before the
Ion Chef™ System finishes chip loading.

Initialization of the instrument can be performed up to 24 hours before starting a
sequencing run. If the intent is to perform two sequencing runs per initialization,
the first run must be completed and the second run started within the 24-hour
period. By initializing the sequencer before completion of chip loading, you
ensure that the chips can be sequenced as soon as possible after loading is
complete.

11. If you chose to pause the run to analyze the templating efficiency, remove the
samples for testing when prompted to do so by the Ion Chef™ Instrument
(approximately 11 hours after the start of the run).

a. When prompted to remove the QC sample, open the instrument door.

Process Paused

A

Run Paused. Please collect QC sample. Close door and press resume
when ready.

I"Continue

IMPORTANT! If you unintentionally close the instrument door before you
obtain the QC samples, you must wait until the end of the run before you
can collect them. You cannot pause the run or open the door after it has been
closed.
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b. Transfer the QC samples (entire volume) from Positions A and B of the
Ion 520™ & Ion 530™ Chef Reagents Cartridge on the instrument deck to two
new labeled microcentrifuge tubes.

IMPORTANT! Do not remove the Library Sample Tubes from the
Ion 520™ & Ion 530™ Chef Reagents Cartridge.

s N
— —

00000000
00000000
‘2000

— —
. J

(D Position A (QC Sample)
(2 Position B (QC Sample)

c. Analyze the QC samples.
d. Close the instrument door, then touch Continue to complete the run.
12. When the run is complete, unload the Ion Chef™ Instrument and sequence the

chips immediately.

Note: If you cannot sequence a loaded chip immediately, place the chip into a
separate chip storage container and store at 4°C until you are ready to sequence
it (up to 6-8 hours maximum).

Note: If you are performing quality assessment of enriched samples, transfer QC
samples from positions A and E of the Enrichment Cartridge v2 to two new
labeled microcentrifuge tubes. See "Supplementary procedures" in the Ion 520™ &
Ion 530™ Kit — Chef User Guide (Pub. No. MAN0010846).
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Unload the chips for sequencing

1. Open the instrument door:

a. In the instrument touchscreen, touch (&) (Open Door) then wait for the latch
to open.

b. Lift the instrument door to the top of the travel until the latch mechanism
engages.

(D Hold here, then lift

2. Open the lid of the Chip-loading centrifuge, then unload both chip/bucket
assemblies from the Ion Chef™ Instrument.

@ Chip-loading centrifuge
(@ Remove

To unload each chip:
a. Remove the chip/bucket assembly from the Chip-loading centrifuge.

b. Apply pressure to both ends of the Chip Adapter, then remove and discard
the Chip Adapter.
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c. Grasp the chip by its edges, carefully lift the chip out of the bucket, then set
it aside on a clean, static-free surface. Return the bucket to the Chip-loading
centrifuge.

(D Chip Adapter
(@ lon chip
(3 Bucket

(® Press and remove adapter
(8 Remove from bucket carefully

3. Close the instrument door by first lifting it slightly to disengage the locking
mechanism, then push down on the door until the locks engage.

IMPORTANT! Do not close the door by pulling it straight down from the open
position. You must lift the door slightly before you can close it. Ensure that both
sides of the door are locked after closing it.

(D Lift door first

(@ Lower

(3 Press down to lock
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4. Load one or both chips into Ion S5™ Sequencers and promptly start the
sequencing runs.

If you cannot sequence a loaded chip immediately or plan to sequence two chips
per initialization, place the chip into a separate chip storage container and store
at 4°C until you are ready to sequence it (up to 68 hours maximum).

IMPORTANT! If you chose to store a loaded chip, remove the chip from the
container and place it on a clean surface in the dark to warm to room
temperature at least 20 minutes before running it.
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Initialize the sequencer

Initialization takes ~40 minutes.

lon S5 System component positions

(D Touchscreen (® lon S5™ Wash Solution bottle. Waste
@ Power button reservoir located behind the Wash
Solution bottle (shown on the right).

(®) lon S5™ Cleaning Solution bottle
() Waste reservoir

(3 lon S5™ Sequencing Reagents cartridge
(& Chip clamp

Note: The system uses RFID technology to verify that the proper reagents are loaded
in positions 3, 5, and 6. Reagents that exceed their expiration date or usage count
generate an error message prompting the user to replace the reagent before
performing the run.

Note: RFID regulatory information can be found on the main screen under
Options » Regulatory info.
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Before you begin

The Ton S5 and Ton S5 XL Sequencers are equipped to verify the compatibility of
each chip and consumable loaded during initialization and sequencing, and that these
components do not exceed their expiration date. To avoid exceptions during
initialization, inspect this information for each consumable before installing onto the
instrument.

e Unbox the Ion S5™ Sequencing Reagents cartridge 45 minutes before use, then
allow it to equilibrate to room temperature.

™

Do not remove the Ion S5™ Sequencing Reagents cartridge from its foil packaging
until immediately before loading, so that you can return the unused cartridge to
storage if your sequencing run is delayed.

e Unbox the Ion S5™ Wash Solution bottle. Invert the bottle 5 times, then swirl at an
angle to mix thoroughly.

* Remove the red cap from the Ion S5" Wash Solution and Ion S5™ Cleaning
Solution bottles immediately before installing on the instrument.

When a manual cleaning of the sequencer is required

™ ™

The Ion S5 Sequencer and Ion S5 XL Sequencer require that a cleaning be
performed before initialization. This is normally performed automatically at the
completion of the previous sequencing run. When two sequencing runs are
performed on a single initialization, the post-run cleaning is performed after the
second sequencing run. However, if the "Enable post-run clean" checkbox (see “Start
the sequencing run” on page 46) is unchecked to allow a second run, and a second
run is not performed, the instrument will not allow the subsequent initialization to
proceed until a manual cleaning has been performed. See “Perform a manual cleaning
of the sequencer” on page 56 for more information on how to perform a manual
cleaning.

™

If an Ion S5™ Sequencer or an Ion S5™ XL Sequencer is initialized and a sequencing
run is not started within 27 hours, or a run is not started or completed due to a power
failure or an abort, do not perform a manual cleaning. A purge and clean sequencing
run is required before reinitialization. See “Perform a purge and clean run with an
initialized, unused Sequencing Reagents cartridge” on page 57 for more

information.
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L5 Initialize the sequencer

Initialize the sequencer

1. In the instrument touchscreen main menu, touch Initialize. The door, chip, and
Reagent cartridge clamps unlock.

@,

Alarms Settings

2. When prompted, remove the Ion S5™ Wash Solution bottle to access the waste
reservoir, then remove and empty the waste reservoir.

3. Reinstall the empty waste reservoir.

4. Replace the expended Ion S5™ Sequencing Reagents cartridge with a new
cartridge equilibrated to room temperature.

5. Ensure the new Ion S5™ Wash Solution bottle is thoroughly mixed. Then remove
the red cap and install.
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Reagent consumables disposal |5

6. Ensure that the used sequencing chip from the previous run is properly seated in
the chip clamp and the chip clamp is pushed in all the way.

7. If necessary, install a new Ion S5™ Cleaning Solution bottle.

Note: The Ion S5™ Cleaning Solution bottle contains sufficient reagent to
complete 4 cleanings.

8. Close the door, then touch Next.

The instrument confirms that the consumables and chip are properly installed
and that the Ion S5™ Cleaning Solution bottle contains sufficient reagent to
perform the post-run clean. Follow all on-screen recommendations to ensure

proper installation of required consumables.

IMPORTANT! If the allowed number of post-run cleans has been met, the

instrument prompts the user to replace the Ion S5™ Cleaning Solution bottle.

Note: See Appendix A, “Troubleshooting” if a Checking Reagent: Failed
warning appears.

9. When initialization is complete (~30-40 minutes), touch Home.

The instrument is now ready for a sequencing run.

Reagent consumables disposal

IMPORTANT! Follow all applicable local, state/provincial, and/or national regulations
when recycling or disposing of Ion S5™ reagent consumables.

CO, scrubber To properly dispose of the CO, scrubber, you must first remove it from the Ion S5
removal and Sequencing Reagents cartridge.
disposal 1. Invert the Ion S5™ Sequencing Reagents cartridge

over an appropriate receptacle to drain all
residual liquid.

2. Wearing gloves, insert the Ion S5™ Cartridge Tool
firmly into the CO, scrubber until the flange
stops on the top of the cartridge. 1

P

lon S5™ Cartridge Tool
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| Reagent consumables disposal

3. Pull straight up on the tool while holding the nucleotide reagent cartridge down.

=5

4. Remove the scrubber from the cartridge tool, then dispose of the scrubber
according to applicable hazardous waste regulations.

Recycle lon S5 The Ion S5 Wash solution and Ion S5 Cleaning solution bottles are made of
Wash and recyclable plastic.
Cleaning solution 1. Open the expended bottle by unscrewing the cap.

bottles
2. Remove the cap, sipper, and filter, then pour any residual liquid into an
appropriate receptacle.

3. Rinse the empty bottle with water. Pour out the rinse water into the same liquid
waste receptacle.

4. Recycle or dispose of the clean bottle, cap, sipper, and filter according to
applicable regulations.
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Start the sequencing run

Chip handling guidelines

To place a chip in the chip clamp:

(‘D Slide the chip clamp out. @ Slide the metal tab in fully to engage the
(2 Remove the chip currently in the clamp. clamp, then close the instrument door.
(3 Place the appropriate loaded chip in the

chip clamp with the chip notch in the
bottom -front corner.

Note: Do not force the chip into the
clamp. If the chip does not fit easily in the
clamp, confirm that the notch is oriented
as shown in the drawing.
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Chapter 5 Start the sequencing run
Start the sequencing run

Start the sequencing run

46

We recommend that you sequence loaded chips on the Ton S5 or Ion S5 XL
Sequencer as soon as possible after chip loading and instrument initialization are
complete. However, successful sequencing runs can be started up to 24 hours after
instrument initialization.

Note: Do not press the power button during a run. Interrupting power to the
instrument during a run may result in sequencing run failure and loss of sample.

1. After completion of initialization, press Run in the instrument touchscreen. The
door and chip clamp unlock.

2. Remove the used sequencing chip, then secure a chip loaded with template-
positive Ion Sphere™ Particles in the chip clamp.

3. Push the chip clamp all the way in to engage, close the instrument door, then
press Next.

4. Confirm that the correct Planned Run has auto-populated, then press Review.
5. (Optional) If this is to be the first of two sequencing runs on this initialization,

deselect the Enable post-run clean checkbox, then press Review.

Note: When starting the second sequencing run on a single initialization, ensure
the Enable post-run clean checkbox is selected so that the post-run cleaning is
performed automatically.

Run Selection
r10-test

Choose a run plan

Planned Run: A7RK6 - Oncomine_Plan

Chip Barcode: |DACA00615

Enable post-run clean

Cancel
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Start the sequencing run — F540

6. Confirm the remaining pre-populated settings are correct, or make changes using
the buttons and dropdown lists if necessary.

Select Run
Confirm the selected run

R 2016 _06 27 19 53_10_ionservice r10-test-67-Oncomine_cfDNA...
lon S5 Sequencing Kit
Run type: TAG_SEQUENCING Library name: hg19

Sample: Project:

Chip barcode: DACA00615 Post-run clean: true

Flows: 500 Notes:

Start run

7. Confirm that the instrument door is closed, then press Start run to begin the
sequencing run.

IMPORTANT! During a run, do not open the instrument door, and avoid
touching the instrument. Touching the instrument during the sequencing run
may reduce the quality of the measurements.

When the sequencing run is complete, the instrument automatically performs the
cleaning procedure unless the Enable post-run clean checkbox was deselected.
After cleaning, the touchscreen returns to the main menu. Use the Torrent
Browser to review the results.
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7998 Chapter 5 Start the sequencing run

Maintain the sequencer

Required * Lint-free wipes
materials e 70% isopropanol
* (optional)-10% bleach solution

Clean or In the event of a spill or leak on or inside the instrument, perform the following steps.

decontaminate the  Note: Dispose of all waste in appropriate liquid or solid waste containers.

sequencer

1.

™

Remove the Ion S5™ Wash Solution bottle, then remove and empty the waste
reservoir.

Remove the Ion S5™ Sequencing Reagents cartridge.
Inspect the waste and nucleotide reagent bays for liquid.

Using absorbent paper soak up as much liquid as possible, then wash the
affected area with 10% bleach solution.

Wipe the affected surfaces with 70% isopropanol, then allow to air-dry.
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Clean the lon Chef " System
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About the cleaning protocol

The Ion Chef™ System includes an automated cleaning function that must be
performed following every run. The cleaning routine is initiated from the Ion Chef
Instrument touchscreen and is designed to minimize potential contamination. During
the routine, the instrument irradiates the deck with ultraviolet light for 1 minute after
all consumables have been removed from the instrument.

TM

IMPORTANT! Although the Ion Chef™ Instrument cleaning routine provides some
protection against contamination, it is not a substitute for good laboratory technique
or precautions. When preparing DNA libraries for use or when preparing the

Ion Chef™ Instrument, make certain to observe sterile laboratory procedures at all
times to ensure minimal contamination.

Materials required

* Gloves, powder-free nitrile
* Isopropanol, 70% solution
e  Wipes, lint-free
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Clean the lon Chef" instrument

O

Clean the lon Chef " instrument

IMPORTANT! Clean the Ion Chef ' Instrument as described below after every run. To
prevent contamination, do not operate the instrument unless it has been recently
cleaned.

1. Open the instrument door:

a. In the instrument touchscreen, touch (&) (Open Door) then wait for the latch
to open.

b. Lift the instrument door to the top of the travel until the latch mechanism
engages.

(D Hold here, then Lift

2. Remove, then dispose of any used consumables from the instrument.

@ Thermal cycler sample block

@ Used pipette tip station

@ Empty Tip Cartridge v2: move to Used pipette tip station
(® Reagents station

(® Solutions station

@ Chip-loading centrifuge

(D Enrichment station
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Recovery centrifuges

a. Remove, then discard the PCR plate from the PCR sample block.

b. Remove, then discard the box of used pipette tips from the waste tip
position.

IMPORTANT! Handle the disposable reservoir in the waste tip position
with care. During the run, liquid waste collects in the reservoir. Dispose of
the liquid waste by tipping the reservoir on one corner and pouring the
waste into an appropriate waste container:

IMPORTANT! Do not reuse the waste pipette tip rack. Always move the
empty Tip Cartridge v2 from the new tip position to the waste tip position.

c. Move the empty Tip Cartridge v2 to the waste tip position.

IMPORTANT! Do not discard the empty Tip Cartridge v2.

d. Remove, then discard the Ion 520™ & Ion 530™ Chef Reagents Cartridge.

IMPORTANT! Make sure to transfer the QC samples before you remove and
discard the Reagents cartridge.

™

e. Remove, then discard the Ion S5 Chef Solutions Cartridge.
f. Close the lid of the Chip-loading centrifuge.
g. Remove, then discard the Enrichment Cartridge v2.

h. Remove, then discard the consumables from the Recovery centrifuges,
including the:

* Recovery Station Disposable Lids v2

* Recovery Tubes v2
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3. Inspect the Recovery centrifuges, then clean the components if excess liquid is

present.
Is liquid Action
present?
No Go to step 4.
Yes Clean the centrifuge bowl and buckets as described below.

IMPORTANT! Clean the Recovery centrifuges occasionally, only
when excess liquid is noticeable in the bowl and/or buckets. You
do notneed to clean the centrifuge after every run.

To clean the Recovery centrifuge bowl and buckets:

IMPORTANT! Wear powder-free, nitrile gloves when cleaning the Recovery
centrifuge.

a. Remove the buckets from the Recovery centrifuges. Clean the inside and
outside of each bucket using a lint-free wipe, then place the buckets on a
clean, dry surface while you clean the centrifuge.

L‘M—@

(D Bucket

(@ Lint-free wipe

b. Use lint-free wipes to clean the inside rim of the centrifuge, then remove all
fluid from the bottom of centrifuge bowl.

T

(™ Inside rim of the centrifuge
(2 Bottom of the centrifuge bowls

Note: When cleaning the centrifuge bowl, fold the wipe in half to provide
extra absorbency.
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Clean the lon Chef" instrument
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c. Use lint-free wipes treated with 70% isopropanol to clean the:
¢ Inside rim of the centrifuge.
* Bottom of the centrifuge bowl.

® Qutside and inside of the centrifuge buckets.
d. Use lint-free wipes to dry the centrifuge and buckets.

e. Install the centrifuge buckets, then close the centrifuge lid.

(1) Buckets [cleaned and installed)

4. Close the instrument door by first lifting it up slightly to disengage the locking
mechanism, then pushing down on the door until the locks engage.

IMPORTANT! Before closing the door, close the lids of the centrifuges.

5. From the Ion Chef™ Instrument touchscreen, start the cleaning;:
a. On the screen that appears after run completion, touch Next.

lon Chef

00:00:00

Complete

Note: You may also clean the instrument at any time starting from the
home touchscreen. Touch Settings, then touch Clean Ion Chef.
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Clean the lon Chef" instrument

b. Confirm that you have removed all consumables from the Ion Chef™

Instrument, then touch Next.

Clean Instrument

Step 10f 2
Unload instrument

. With the door closed, touch Start. The instrument performs a Deck Scan

T™

before starting the cleaning routine. The Ion Chef™ Instrument stops
ventilation, then illuminates the ultraviolet (UV) light in the instrument for
~1 minute.

Clean Instrument

Step 2 of 2
Check & clean

1. Close door by pushing up to unlock,
then press down to close

2. Press start to begin

CAUTION! The Ion Chef™ Instrument emits UV light at 254 nm. Wear
appropriate eye wear, protective clothing, and gloves when working
near the instrument. Do not look directly at the UV light while it is
illuminated during the cleaning routine.
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Troubleshooting

Refer to Jon 520" & lon 530" Kit - Chef User Guide

Refer to lon 520™ & Ion 530™ Kit — Chef User Guide (Pub. No. MAN0010846) for
troubleshooting information.
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Supplemental procedures

Perform a manual cleaning of the sequencer

A cleaning protocol is normally performed automatically at the completion of each
sequencing run. In the event that a cleaning is necessary, follow the listed steps:

1.

56

On the home screen, select Settings » Clean Instrument.
The instrument door unlocks allowing access to the consumables.

Remove the Ion S5™ Wash Solution bottle to access the waste reservoir, then
remove and empty the waste reservoir.

™

Reinstall the empty waste reservoir and the used Ion S5 Wash Solution bottle.

™ ™

Ensure the Ion S5™ Sequencing Reagents cartridge and Ion S5 Cleaning Solution
bottle are properly installed.

IMPORTANT! Perform the cleaning with a used reagent cartridge and wash
solution bottle installed. The cleaning procedure pumps cleaning solution into
the wash solution bottle and reagent cartridge making them unsuitable for
sequencing.

Place a used sequencing chip in the chip clamp, then push the chip clamp in all
the way to engage.

Close the instrument door, then press Next.

Cleaning takes ~35 minutes to complete. Upon completion the instrument door
automatically unlocks and the chip and cartridge clamps disengage.

Proceed to “Initialize the sequencer”.
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Perform a purge and clean run with an initialized, unused Sequencing Reagents
cartridge

Perform a purge and clean run with an initialized, unused
Sequencing Reagents cartridge

Cleaning is normally performed at completion of a sequencing run automatically. If
anlon S5 Sequencer or an Ton S5 XL Sequencer is initialized and

* asequencing run is not started within 27 hours after initialization, or

* asequencing run is not completed due to a power failure or an abort,

a purge and clean sequencing run is required to ensure proper cleaning before
reinitialization. Do NOT perform a manual cleaning with an unused, initialized Ion
S5 Sequencing Reagents cartridge.

Note: If a power failure or abort occurs during the second of two runs started after a
single initialization, a manual cleaning (page 56) is sufficient.

To perform a purge and clean run, use the following procedure before reinitialization:

1.

In the instrument touchscreen main menu, press Run.
The instrument door and chip clamp unlocks.

Ensure that a used sequencing chip is in the chip clamp, then push the chip
clamp in all the way to engage.

Close the instrument door, then press Next.

When prompted, select Planned Run (none). Ensure that the Enable post-run
clean checkbox is selected, then press Review.

In the Select Run screen, press Edit, then in the Detail screen set the number of
flows to 500 manually. Ensure that the Post-Run/Clean checkbox is selected, then
press Close.

Press Start run, then press Accept to confirm that Post-Run Clean is enabled, and
to start the run.

When the purge sequencing run completes, the instrument automatically performs
the cleaning procedure. After cleaning, the touchscreen returns to the main menu.
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Maintain the lon Chef System

Install a firmware
update

58

The Ion Chef™ System supports the user-performed maintenance procedures found in
this section.

To ensure proper operation of the Ion Chef™ Instrument, we recommend periodically
confirming that your instrument is running the most current firmware. We
occasionally release updates to the instrument firmware, which can include important

T™

changes to the Ion Chef™ System operation. To ensure that your instrument is running
the most current firmware, check the firmware version as explained below.

Check the lon Chef” Instrument firmware
. On the Ion Chef™ Instrument touchscreen, touch Settings.

2. On the Settings screen, touch Check for updates.

3. On the Software Update screen, touch Release to search the server for updates to

the Ion Chef™ Instrument firmware.

Software Update

@ Release Component

C* uss InstrumentServer-123
lonChef_gui-62
0S_update-27
GM_update-23

IS_scripts-61

Note: Users are also notified of the availability of firmware updates on the
Notifications screen.

Select the available component update, touch Update, then wait for the
instrument to complete the update.

Note: If the Ion Chef™ Instrument is operating on an isolated network and
cannot connect to our website, you must transfer the firmware update manually.
To perform a manual update, transfer the firmware files to a USB drive and insert
the drive into the USB port at the rear of the instrument. Touch USB on the
Software Update screen, select from the list of available software components,
then touch Update.

When finished, the Ion Chef™ Instrument displays the update status.

Power off and on the Ion Chef™ Instrument to complete the update.

IMPORTANT! If you are updating the firmware manually, remove the USB drive
before powering on the Ion Chef™ Instrument.
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Download and install BED files

Change the The following procedure describes how to change the name used to identify the Ion
instrument name Chef" Instrument both on the network and in the data that it generates.

1. In the Ion Chef™ Instrument home screen, touch Settings.
2. In the Settings screen, touch Instrument settings.

3. In the Instrument settings screen, touch Set Instrument Name. Touch the name
field and enter a new instrument name using the keypad that appears, then
touch Save.

Note: Use only alphanumeric characters. Do not use special characters or spaces
in the name.

Instrument Name

Instrument name

4. In the next screen, touch Save again. Power off and on the Ion Chef™ Instrument
to effect the name change.

Download and install BED files

Up-to-date Oncomine " cfDNA Assay BED files are available from thermofisher.com.

1. In the Thermo Fisher Scientific homepage, enter "Oncomine™ cfDNA Assay" (or
the product catalog number) into the search field, then press Enter.

2. Navigate to the appropriate assay product page, scroll down to Product
literature, then click on the desired Target Regions or Hotspots .zip BED file.
The file will automatically begin to download.

3. Log in to the Torrent Server where you want to install the Target Regions and
Hotspots BED files.

4. Click the £ "Gear" tab, then select References from the dropdown list.

5. Upload the Target Region panel .BED file:
Note: It is not necessary to extract the .zip file prior to uploading the .bed file.

a. In the left navigation menu, click Target Regions, then click the Add Target
Regions button.

b. Select hgl9 - Homo sapiens from the Reference dropdown list.
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Download and install BED files

c. Click Select File, then navigate to and select the downloaded Target
Regions .zip file:
* Oncomine_Lung_cfDNA.06012016.Designed.bed
* Oncomine_Colon_cfDNA.10242016.Designed.bed
* Oncomine_Breast_cfDNA.08032016.Designed.bed

New Target Regions

Target Regions File : Select File
Please select a BED file to upload.

ImmuneResponse_v3.1 - Immune Response (v3.1)

Description :

Notes :

d. Click Open, then click Upload Target Regions File.

6. Upload the Hotspots .BED file:
Note: It is not necessary to extract the .zip file prior to uploading the .bed file.
a. In the left navigation menu, click Hotspots, then click the Add Hotspots
button.

b. Select hgl9 - Homo sapiens from the Reference dropdown list.

c. Click Select File, then navigate to and select the downloaded Hotspots .zip
file:
¢ Oncomine_Lung cfDNA.06012016.Hotspots.bed
* Oncomine_Colon_cfDNA.10242016.Hotspots.bed
* Oncomine_Breast_cfDNA.08032016.Hotspots.bed

d. Click Open, then click Upload Hotspots File.

The Target Regions and Hotspots BED files upload to your Torrent Server and appear
in the respective dropdown lists.
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Guidelines for lon OneTouch' 2
System users

Proceed to template preparation and sequencing using the following kits appropriate
to your instrument setup. To create a specific Run Plan for use in templating and
sequencing see “Create a Planned Run” on page 14. Refer to the user guide listed in
the following table for more information.

Template System

Sequencer Kit User Guide

lon OneTouch™ 2

lonS5™ | lon 520™ & lon 530™ Kit - OT2 lon 520" & lon 530" Kit - OT2 User Guide
(Cat. No. A27751) (Pub. No. MAN0010844)
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Safety

/AN

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the

instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

- Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

- Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.

Symbols on this instrument

Symbols may be found on the instrument to warn against potential hazards or convey
important safety information. In this document, the hazard symbol is used along with
one of the following user attention words:

* CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

* WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

* DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury.

Symbol

English

Francais

/AN

Caution, risk of danger

Consult the manual for further safety
information.

Attention, risque de danger

Consulter le manuel pour d'autres
renseignements de sécurité.

S

Protective conductor terminal (main
ground)

Borne de conducteur de protection
(mise a la terre principale)
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Symbols on this instrument

Symbol | English

Francais

|3

Do not dispose of this product in
unsorted municipal waste

CAUTION! To minimize
negative environmental
impact from disposal of
electronic waste, do not

Ne pas éliminer ce produit avec les
déchets usuels non soumis au tri
sélectif.

CAUTION! Pour minimiser
les conséquences négatives
sur l'environnement a la suite

dispose of electronic waste in de Uélimination de déchets

unsorted municipal waste.

électroniques, ne pas élimin-

Follow local municipal waste er ce déchet électronique

ordinances for proper
disposal provision and

avec les déchets usuels non
soumis au tri sélectif. Se con-

contact customer service for former aux ordonnances lo-
information about responsible cales sur les déchets munici-

disposal options.

paux pour les dispositions
d'élimination et communi-
quer avec le service a la cli-
entele pour des renseigne-
ments sur les options d’élimi-
nation responsable.

Conformity The following table applies only to the Ion Chef " Instrument.
mbol
symbols Conformity -
Description
mark

Indicates conformity with safety requirements for Canada and U.S.A.

Indicates conformity with European Union requirements for safety and
electromagnetic compatibility.

Indicates conformity with Australian standards for electromagnetic

compatibility.
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Location of safety labels on this instrument

Location of safety labels on this instrument

Safety information for instruments not manufactured by Thermo
Fisher Scientific

Some of the accessories provided as part of the instrument system are not designed or
built by Thermo Fisher Scientific. Consult the manufacturer's documentation for the
information needed for the safe use of these products.

Instrument safety

General & CAUTION! Do not remove instrument protective covers. If you remove the
protective instrument panels or disable interlock devices, you may be exposed
to serious hazards including, but not limited to, severe electrical shock, laser
exposure, crushing, or chemical exposure.

Physical injury é CAUTION! Moving Parts. Moving parts can crush, pinch and cut. Keep hands
clear of moving parts while operating the instrument. Disconnect power before
servicing.
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Electrical

Cleaning and
decontamination

Ultraviolet (UV)
Safety

Appendix D Safety
Safety and electromagnetic compatibility [EMC) standards

WARNING! Ensure appropriate electrical supply. For safe operation of the
instrument:

. Plug the system into a properly grounded receptacle with adequate current
capacity.

- Ensure the electrical supply is of suitable voltage.

- Never operate the instrument with the ground disconnected. Grounding
continuity is required for safe operation of the instrument.

WARNING! Power Supply Line Cords. Use properly configured and approved
line cords for the power supply in your facility.

>

WARNING! Disconnecting Power. To fully disconnect power either detach or
unplug the power cord, positioning the instrument such that the power cord is
accessible.

CAUTION! Cleaning and Decontamination. Use only the cleaning and
decontamination methods specified in the manufacturer's user documentation.
It is the responsibility of the operator (or other responsible person) to ensure
the following requirements are met:

- No decontamination or cleaning agents are used that could cause a
HAZARD as a result of a reaction with parts of the equipment or with
material contained in the equipment.

- The instrument is properly decontaminated a) if hazardous material is
spilled onto or into the equipment, and/or b) prior to having the instrument
serviced at your facility or sending the instrument for repair, maintenance,
trade-in, disposal, or termination of a loan (decontamination forms may be
requested from customer service).

. Before using any cleaning or decontamination methods (except those
recommended by the manufacturer), users should confirm with the
manufacturer that the proposed method will not damage the equipment.

™

The Ion Chef™ System uses a UV lamp which emits light at 254 nm. Under normal
operating conditions, the UV lamp is powered on when performing the cleaning
protocol. Safety interlocks are used to ensure that the UV lamp is not powered when
the door is open.

Safety and electromagnetic compatibility (EMC) standards

The instrument design and manufacture complies with the standards and
requirements for safety and electromagnetic compatibility as noted in the following

table:
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Safety and electromagnetic compatibility [EMC) standards

Safety compliance

EMC

Environmental
design

66

Reference Description
EU Directive European Union “Low Voltage Directive”
2006/95/EC
IEC 61010-1 Safety requirements for electrical equipment for measurement,
EN 61010-1 control, and laboratory use - Part 1: General requirements
UL 61010-1
CSA C22.2 No.
61010-1

IEC 61010-2-010
EN 61010-2-010

Safety requirements for electrical equipment for measurement,
control and laboratory use — Part 2-010: Particular requirements
for laboratory equipment for the heating of materials

IEC/EN 61010-2-020

Safety requirements for electrical equipment for measurement,
control and laboratory use — Part 2-020: Particular requirements
for laboratory centrifuges

IEC 61010-2-081
EN 61010-2-081

Safety requirements for electrical equipment for measurement,
control and laboratory use — Part 2-081: Particular requirements
for automatic and semi-automatic laboratory equipment for
analysis and other purposes

Reference

Description

Directive 2004/108/EC

European Union "EMC Directive”

FCC Part 15

U.S. Standard “Industrial, Scientific, and Medical Equipment”

AS/NZS 2064

Limits and Methods of Measurement of Electromagnetic
Disturbance Characteristics of Industrial, Scientific, and
Medical [ISM] Radiofrequency Equipment

ICES-001, Issue 3

Industrial, Scientific and Medical [ISM] Radio Frequency
Generators

Reference

Description

Directive 2012/19/EU

European Union "WEEE Directive” - Waste electrical and
electronic equipment

Directive 2011/65/EU

European Union “RoHS Directive” - Restriction of hazardous
substances in electrical and electronic equipment
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below. Consult the relevant SDS
for specific precautions and instructions:

- Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

- Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

- Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood).

- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.

- Handle chemical wastes in a fume hood.

- Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

- After emptying a waste container, seal it with the cap provided.

- Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

- Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

- IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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Biological hazard safety

68

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Conduct all work in properly equipped facilities
with the appropriate safety equipment (for example, physical containment
devices). Safety equipment can also include items for personal protection, such
as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety
glasses, or goggles. Individuals should be trained according to applicable
regulatory and company/ institution requirements before working with
potentially biohazardous materials. Follow all applicable local, state/provincial,
and/or national regulations. The following references provide general
guidelines when handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological
and Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC)
21-1112, Revised December 2009; found at:
www.cdc.gov/biosafety/publications/bmbl5/BMBL.pdf

- World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/cst/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation

Document

Description

Oncomine™ cfDNA Assays, Part |- Library
Preparation User Guide
(Pub. No. MAN0014688)

Describes the preparation of Oncomine™
cfDNA Assay libraries.

Oncomine™ cfDNA Assays, Part Il: Plan a
Run, Template Preparation, and
Sequencing User Guide

(Pub. No. MAN0015873)

Describes the automated template
preparation of Oncomine™ cfDNA Assay
libraries using the lon Chef" System for
sequencing on the lon S5 System.

Oncomine™ cfDNA Assays, Part Ill: Variant
Analysis User Guide
(Pub. No. MAN0015874)

Describes how to perform variant analysis
on Oncomine cfDNA Assay sequence data,
and how to view, sort, and filter results.

Note: For additional documentation, see “Customer and technical support” on

page 69.

Obtain information from the Help system

The Torrent Suite” Software has a Help system that describes how to use each feature

of the user interface.

™

In the toolbar of the Torrent Suite™ Software window, click Help » Software Help.

You can use the Help system to find topics of interest by:

* Reviewing the table of contents

* Searching for a specific topic

Customer and technical support

Visit thermofisher.com/support for the latest in services and support, including:

* Worldwide contact telephone numbers

¢ Product support, including:
— Product FAQs

— Software, patches, and updates

— Training for many applications and instruments

¢ Order and web support
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Documentation and support
Limited product warranty

* Product documentation, including:
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,
contact the manufacturer.

Limited product warranty

70

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.thermofisher.com/us/en/home/global/
terms-and-conditions.html. If you have any questions, please contact Life
Technologies at www.thermofisher.com/support.
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For support visit thermofisher.com/support or email techsupportf@lifetech.com ThermoFisher
thermofisher.com SCIENTIFIC

14 November 2016
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